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1 Introduction

DropDMG is a utility for creating disk images in Mac OS X’s device image (DMG) format.
Disk images are a wonderful way of packing entire folders or disks into a single file, either
for transport across the Internet or simply for achival. Unlike StuffIt and Tar archives, they
preserve long filenames and Mac and Unix metadata. DMG images may be created using
Apple’s Disk Copy utility, and Disk Copy can also “mount” an image—make its contents
accessible as if they resided on an inserted CD-ROM. Although Disk Copy comes free with
Mac OS X, DropDMG goes beyond what Disk Copy offers, both in power and ease of use.

Here’s a brief rundown of DropDMG’s features:

• Supported formats: zlib-compressed, ADC-compressed, read-only, read-write, NDIF
(.img).

• Make encrypted compressed disk images and post-process images with GZip or MacBi-
nary.

• Make images auto-open when you mount them.

• All options are available from AppleScript.

• Include rich text license agreements, in multiple languages.

• Create more than one image a time to take advantage of dual processors, or just so
you don’t have to babysit it when creating multiple images.

• Reliability. Like all good Mac applications1, DropDMG has no trouble handling folders
with spaces, quotation marks, dollar signs, or other “special” characters.

• Fix downloaded DMGs so that they open in Disk Copy.

• Does not require Mac OS X’s optional “BSD Subsystem” installation.

• Clean and simple interface that stays out of your way and respects your screen real
estate.

1But, sadly, unlike many quick-and-dirty utilities and shell scripts.
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2 Installation

DropDMG has been developed and tested on Mac OS X 10.1.5. I do not have the resources
to test it on older systems, although I suspect it will work fine on Mac OS X 10.1 or later.
DropDMG does not require Mac OS X’s optional “BSD Subsystem” installation.

Double-click the DropDMG-1.7.dmg file to mount the image with Disk Copy. If you like,
you can run DropDMG directly from the image to test it out. To install, simply copy the
application to your hard disk, e.g. into /Applications/Utilities.

There’s no need to copy this manual to your hard disk. A copy of it is built-into
DropDMG, and you can access it by choosing DropDMG Manual (PDF) from the Help
menu. Apple Help is also available by choosing DropDMG Help from the Help menu.

3 Using DropDMG

3.1 Making Disk Images

There are several ways to create disk images using DropDMG. The top of the status window
shows the options that will be used to create the image.

Drag and Drop Drag and drop one or more folders onto the DropDMG icon, either in the
Finder or in the Dock; or onto the status window.

Menu Choose New Folder Image... from the File menu.

AppleScript You can use AppleScript to automate the creation of an image. For example:

tell application "Finder"
-- ask the user
set myFolder to choose folder

-- or use a path
set myFolder to alias "HD:Users:me:folder:"

end tell
tell application "DropDMG"

-- create an image using the options in the preferences
open myFolder

-- or specify the options with AppleScript
create image from folder myFolder destination "/Users/me/folder"

format ADC compressed with encryption and gzip
end tell

When you create an image using the create image verb, the AppleScript command
will not return until after the image has been created. You may wish to use Apple-
Script’s with timeout construct when creating large images. Due to limitations in

3



Cocoa, you cannot enqueue more image operations while DropDMG is processing an
AppleScript command; however, any operations already in progress will proceed and
complete as normal.

Command-Line To create disk images using the options specified in the preferences, you
can use open2 and pass the folders as arguments:

open -a DropDMG.app ~/path/to/a/folder ~/another/folder

If you want to specify options from the command line, use osascript -e to run an
AppleScript, as above.

3.2 Fixing Disk Images

Sometimes a downloaded disk image won’t open in Disk Copy because the Web server told
the Web browser that the disk image was a text file. DropDMG can fix such images by
setting their type and creator codes so that the Finder will open them in Disk Copy. There
are several ways to fix disk images:

• Drag and drop one or more disk images onto the DropDMG icon or onto the status
window.

• Choose Fix Disk Image... from the File menu.

• Use open with AppleScript or the command line, as above.

3.3 The Status Window

The top half of the status window displays the current options that will be used for creating
images. You can drag folders onto this portion of the window to create images. Control-
click on the striped portion of the window to quickly change common preferences using a
contextual menu.

The button half of the status window displays a log of the images that DropDMG has
created and fixed. Choose Clear Log from the File menu to erase the contents of the log.

3.4 License Agreements

Disk images can include license agreements, which are displayed to the user whenever Disk
Copy mounts the image3. DropDMG lets you define multiple license agreements ahead of
time. Each agreement may be localized into multiple languages. You can choose which

2Note that open will return before DropDMG has finished creating the image, so if you are writing a
shell script that will act on the finished image file it’s best to use osascript and DropDMG’s AppleScript
interface, instead.

3Such agreements are of questionable legal value and many users find them annoying. Make sure that
you are including a license agreement for a good reason.
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agreement (if any) to include in the preferences. When you make an image, DropDMG will
add that agreement, and all its localizations, to the image file.

To manage your license agreements, choose Show Agreements from the License
Agreements menu. This opens the License Agreements window, which displays the
agreements and localizations you have defined. The license agreements are automatically
saved in DropDMG’s preferences file.

To make a new license agreement, choose Add Agreement... from the License Agree-
ments menu. The created agreement will be empty. You can rename it by double-clicking
the agreement’s name. In order to type the text of the agreement, use Add Language...
from the License Agreements menu. This creates an entry in the License Agreements
window for a new localized variant.

To edit the text of an agreement, double-click on one of its languages in the License
Agreements window. This opens an editing window where you can type. You can view
and edit multiple localizations at once, if you want. The Edit menu contains commands for
checking spelling and text-to-speech.

Use the Delete Selection command in the License Agreements menu to delete the
selected agreement or localization.

License agreements can use multiple fonts, sizes, and styles of text. Beware, however, of
using fonts that are not built into Mac OS X, for the license agreement will look different
if the user does not have the fonts installed. Secondly, note that “synthetic” font attributes
will not be preserved between DropDMG and Disk Copy. A synthetic attribute is a style for
which you do not have a font. For instance, Mac OS X ships with normal and bold variants
of Lucida. Both of these work fine in license agreements. DropDMG will also let you create
a license agreement using italic Lucida, where the operating synthesizes Lucida Italic from
regular Lucida, but this will not be displayed in Disk Copy.

4 Setting the Preferences

4.1 Image Format

DropDMG supports the following image formats:

zlib-compressed zlib creates the smallest disk images, but they only work on Mac OS 10.1
and later. This is DropDMG’s recommended format for general use.

ADC-compressed ADC images are a bit larger and slower than zlib images, but they work
on Mac OS X 10.0 and later.

NDIF-compressed NDIF images work with Disk Copy 6.x on Mac OS 9, as well as on
Mac OS X. They have resource forks and so must be encoded with a utility such as
StuffIt, MacBinary, or BinHex before they are shared on the Internet. NDIF images
do not support encryption and they are limited to 2 GB.

Read-only Read-only images require Mac OS X and are larger than zlib- and ADC-
compressed images. However, when post-compressed with GZip they may end up
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smaller than the other formats. Read-only images are also a good choice when the
folder you are imaging contains internally compressed files such as MP3s or JPEGs;
in this case, using a compressed image format takes significantly longer and does not
save much more space.

Read-write Read-write images can be mounted in the Finder and their contents modified.
DropDMG creates read-write slightly larger than needed to hold all the files4. This
allows you to make minor modifications such as repositioning icons and creating aliases
to other files on the image. Once the image is exactly the way you want it, you can
use Disk Copy to convert the read-write image into a compressed one.

4.2 Encrypt images

Encrypted images require a password for access. They only work on Mac OS X 10.1 and
later. Encrypted images are much slower to access than unencrypted images. DropDMG
uses Apple’s implementation of the AES-128 algorithm. More information is available at
http://csrc.nist.gov/encryption/aes/.

4.3 Limit segments to MB

This option lets you set a maximum size for image files. If an image requires more space
than the set limit, DropDMG will split the image into two or more files.

4.4 Post-compress with GZip

With this option selected, DropDMG will compress DMG images so that you end up with a
.dmg.gz file. This compression is in addition to the zlib/ADC compression that is intrinsic
to the image format, so the resulting file will be a bit smaller. Some Web servers have trouble
handling plain .dmg files, so that when people download them they open in the Web browser
instead of Disk Copy. Using .dmg.gz files eliminates this problem, at the expense of an extra
decompression step after downloading (usually using StuffIt Expander or OpenUp).

Note that this option requires that Mac OS X’s optional “BSD Subsystem” package be
installed.

If you use GZip in combination with “Limit segments,” DropDMG will GZip each segment
of the image. Some segments may compress better than others, so it is normal for the
segments to be of unequal size after GZipping.

GZip compression is disabled for NDIF images because it does not work with files that
have resource forks.

4.5 Encode with MacBinary

NDIF image files cannot be directly transmitted on the Internet because they have resource
forks. MacBinary encoding converts the image to a data fork–only file that can be safely

4If you just want to create a blank image of a particular size, Apple’s Disk Copy does nicely.
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uploaded to Web and FTP servers, even using software that’s improperly configured or not
Mac-savvy.

MacBinary encoding is disabled for DMG images because they are already data fork–only.

4.6 Prompt for image and volume names

With this option selected, DropDMG will ask you to enter the name of the image file it will
create and the name of the volume that will appear on the desktop when you mount the
image. DropDMG will automatically add the proper filename extension (.dmg or .img) to
the image name. It may also truncate the names you enter if they would be too long for the
Mac’s volume and filename limits.

With this option deselected, DropDMG will assign the image and volume names based
on the name of the folder being imaged.

4.7 Include license agreement

With this option selected, Disk Copy will display a license agreement each time the image
is mounted. Use the popup menu to select the license agreement you want included. This
option is disabled if you have not entered any license agreements. To add a license agree-
ment, choose Show Agreements from the License Agreements menu. Then choose Add
Agreement... to add an agreement and Add Language... to add at least one language.

4.8 Auto-open image windows

With this option selected, DropDMG will make images that automatically open their root
folder when mounted. That is, when you double-click the image in the Finder, its window
will open. This is especially useful for images that you will be distributing to other users.
Depending on how their Finders are configured, they may not see the image’s icon appear
on the desktop; therefore, making the image window auto-open provides a superior user
experience.

4.9 Saving Images

You can choose to have images created in the same folder as the source folder, or specify a
folder where all images should be saved. Note that if you specify a destination folder that’s
contained by the source folder, DropDMG will revert to its default behavior of saving the
image next to the source folder.

4.10 When Imaging a Package

Some Mac OS X files, such as a applications, are actually special folders called packages.
The system presents packages to the user as a single file, but they’re actually stored on disk
as folders. Normally, when DropDMG makes an image from a folder it copies the contents
of the folder into the image; that is, the mounted image behaves just like the original folder
did.
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Since packages are folders, you can make images of them with DropDMG. However, if
DropDMG proceeds as usual, when you mount an image that was created from a package,
the Finder will think that the mounted image is a package. It will show the package icon
instead of the disk image icon, but it won’t let you double-click the mounted image to access
the package (e.g. launch the application). You might think that you could drag the mounted
image to your hard disk to launch the application from there, but the Finder will create an
alias instead (unless you know to hold down Option).

Therefore, by default, DropDMG recognizes when you are imaging a package and gives
you a disk image with the package inside it, instead of making an image of the package. To
disable this feature, and thus have DropDMG treat all folders consistently, click the Copy
contents of package radio button.

5 Contact Information

The DropDMG Web site is located at http://www.c-command.com/dropdmg/. Questions
about DropDMG may be sent to mailto:support@c-command.com. I’m always looking to
improve DropDMG, so please feel free to send any feature requests to that address.

To make sure that you have the latest version of DropDMG, you may wish to subscribe
to the DropDMG Announcements mailing list. The traffic on this list is very low, only
one message per new version of DropDMG. You may sign up using the form at http:

//www.c-command.com/dropdmg/support.shtml.

6 Registering

DropDMG is shareware. If you find yourself using DropDMG beyond a reasonable trial
period, you must register it. Registration costs $5 (US) and entitles you to free updates and
support.

To register, go to http://store.eSellerate.net/s.asp?s=STR804431608. Soon after
paying, you’ll receive an e-mail with your serial number. Enter it in the Registration window
to personalize your copy of DropDMG.

This is the honor system. If you use DropDMG without registering, I probably won’t
know. However, registering will give me an incentive to continue updating and enhancing
DropDMG, and to write more Mac software. And you won’t have to look at the “Unregis-
tered” in the status window anymore.

7 Notes and Limitations

• The destination volume must have free space at least equal to twice the size of the
folder, because DropDMG needs space to compress the image.

• Dragging a volume onto DropDMG creates an image that contains the volume’s con-
tents, not an image of the device. Use Disk Copy to create images of devices, e.g. to
make an image of a bootable CD-ROM.
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• DropDMG will not copy Desktop DB, Desktop DF, or .Trashes to the top level of
the disk image. These files are managed by the operating system and should not be
replaced. Do not create your own files with these names at the top level of your source
folder.

• DropDMG cannot create an image of the startup volume. (You’ll get a slightly con-
fusing error message.)

• Due to a bug in Mac OS X, DropDMG may fail when copying extremely large (1 GB)
files to the disk image. The workaround is to upgrade to Mac OS 10.2 (Jaguar).

Future versions of DropDMG may address these issues.

8 Version History

1.7—August 12, 2002

• Added support for license agreements. License agreements support rich text and may
be localized.

• The image destination path is now stored abbreviated with a tilde, if possible. This
should help people who have multiple boot partitions.

• The log is printable.

• Finer-grained progress bar and status text.

• If adding the requisite filename extensions would make the requested image name longer
than the limit, DropDMG will now quietly truncate the name rather than stopping
with an error.

• NDIF images are now created with filenames of 31 characters or less, so that there
won’t be any name mangling when they’re viewed in Mac OS 9.

• DropDMG now truncates .dmg volume names to 62 characters and .img volume names
to 27.

• Fixed bug where DropDMG could deadlock after certain kinds of errors.

• Fixed bug where DropDMG sometimes didn’t detect filename collisions until after it
started making the image.

• Fixed bug where DropDMG would overwrite pre-existing .dmgpart files if the first
segment was not present and the newly created image happened to have the same
name.

• Renamed some File menu commands.
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1.6—July 15, 2002

• Option to make images auto-open. When you mount an image, its window opens in
the Finder. Previously, there might have been no visual indication that the image had
mounted, depending on how the user’s Finder preferences were set.

• The status window has a contextual menu for quickly changing common preferences.

• You can optionally set the names of the image file and volume, instead of having them
based on the name of the folder.

• Documentation is now included in Apple Help (HTML) format as well as PDF.

• Contains a menu command for clearing the log.

• No longer fails when copying files for which the user only has read privileges. Previ-
ously, DropDMG would copy the file and permissions and then report a permissions
error when it tried to set the catalog information of the copy, which wasn’t writable.

• The radio buttons for selecting where the image will be saved are no longer linked to
the image destination text field. That is, tabbing of the text field no longer affects the
radio button’s selection, making the preferences more friendly for keyboard navigators.

1.5—May 2, 2002

• Multi-threading—DropDMG can create more than one image at a time, and the inter-
face remains responsive.

• Can divide large images into multiple segments of fixed size.

• Creates uncompressed read-only images, which often compress better with GZip than
internally-compressed image files do.

• Creates read-write images.

• Encodes Mac OS 9 .img images with MacBinary so that they can be transferred on
the Internet.

• The status window displays a log that shows all the completed operations and errors.

• The status window now shows all the format options that are in effect.

• Faster copying of Mac metadata.

• Worked around Apple bug that sometimes caused errors when creating large images.

• Fixed bug where DropDMG mistakenly resolved symlinks when copying Mac metadata.
This had caused some metadata not to be copied, and also caused image creation to
fail if the user didn’t have write access to the original file.
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• Fixed regression where DropDMG sometimes didn’t complain when the destination
folder was inside the source folder.

• Tries several times to eject images, rather than giving up immediately.

• More detailed reporting of file copy errors.

• More accurate reporting of what state the image creation process is in when errors
occur.

• Mailing list for version announcements has a Web interface.

1.3.1—March 11, 2002

• You can now create images by dragging and dropping folders into the status window.

• The status window’s indication of the progress is more accurate.

• Fixed regression in which images couldn’t be created on non-boot volumes.

• Fixed regression in which images couldn’t be created in ~/Desktop if the destination
folder had never been manually set.

1.3—February 25, 2002

• You can now choose whether images are saved next to the source folder, or in a user-
defined folder.

• Volume images are now created in ~/Desktop by default (instead of /Volumes).

• Resolved problem in which DropDMG tried to replace invisible system files on the
image, if the source folder contained items with the same names.

• The format parameter is now optional when creating images with AppleScript.

• Notifies the system after fixing an image’s type and creator.

• Fixed bug in which DropDMG would report the wrong file as the cause of a copy error.

• The keyboard loop in the Preferences window should work again.

• The status window no longer flickers when the program first opens.

• The distribution is smaller, since the manual uses fewer images.

1.2.1—February 11, 2002

• Uses Carbon to preserve Finder info (e.g. the locked, stationery, and custom icon bits)
when copying files.

11



1.2—February 3, 2002

• All options are now available from the scripting interface.

• No longer requires Mac OS X’s optional “BSD Subsystem” installation.

• Optionally post-compresses DMGs with GZip.

• Fixes type and creator codes of DMGs.

• Preferences window is easier to use; now, enablement is only tied to the Image Format
radio buttons.

• Capitalizations now follow the Aqua Human Interface Guidelines.

1.1—January 28, 2002

• Supports ADC and NDIF compression for compatibility with Mac OS 10.0.x and Mac
OS 9, respectively.

• Supports encrypted compressed images in the zlib and ADC formats.

• Optionally detects packages so that you end up with a mounted image containing the
package instead of a mounted image that the Finder thinks is a package.

• Copies locked files to images (instead of stopping with an access error).

• Images’ logical sizes are smaller; this should slightly reduce their physical sizes and
reduce mount times.

• Accepts drops of all file types (including packages); if DropDMG doesn’t know how to
handle a dropped file it will just ignore it.

• The Make Image From Folder... menu command lets you choose packages and
subfolders of packages (instead of just vanilla folders).

• Minor UI tweaks.

1.0—January 21, 2002

• First public release.
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9 Legal Stuff

DropDMG and this manual are copyright c© 2002 Michael Tsai, mailto:mjt@c-command.
com. All rights reserved.

The MacBinary III encoder is copyright c© 2001 Gregory L. Guerin. DropDMG uses it in
unmodified binary form under the terms of the Artistic License. Thanks, Greg! The original
source is available from http://www.amug.org/~glguerin/sw/.

Please distribute the unmodified DropDMG-1.7.dmg file on the Web, LANs, compilation
CD-ROMs, etc. Please do not charge for it (beyond a reasonable cost for media), or distribute
the contents of the image file in isolation.

This software is provided by the copyright holders and contributors “as is” and any
express or implied warranties, including, but not limited to, the implied warranties of mer-
chantability and fitness for a particular purpose are disclaimed. In no event shall the regents
or contributors be liable for any direct, indirect, incidental, special, exemplary, or consequen-
tial damages (including, but not limited to, procurement of substitute goods or services; loss
of use, data, or profits; or business interruption) however caused and on any theory of lia-
bility, whether in contract, strict liability, or tort (including negligence or otherwise) arising
in any way out of the use of this software, even if advised of the possibility of such damage.

DropDMG is a trademark of Michael Tsai. Mac is a registered trademark of Apple
Computer. All other products mentioned are trademarks of their respective owners.
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